




Annexure ‘A’ 

 

SETUP OF ROVER (R8s) 
 

Step 1: Turn on the Receiver R8s Rover and notice the light blinking. 

 

 
Step 2: Mount the Receiver R8s Rover on the rod provided and place it vertical exactly over the Rover 

station mark with the help of bipod. 

Step 3: Check the verticality of the rod viewing the bubble. Adjust the bipod legs if necessary. 

Step 4: Connect Field Data Collector (Getac tab) to Wi Fi internet connection. 

Step 5: Pair Field Data Collector (Getac tab) to the receiver R8s Rover with Bluetooth 

connectivity.Forthis go to Bluetooth icon in Field Data Collector (Getac tab), Add and pair Bluetooth 

device i.e. Rover, by steps shown in the following slides serially. 



 
 

 

 



 
 

 
Step 6: Enter default PIN 0000 and click Connect tab. Your device is ready to go! message will be 

displayed for paired device R8s receiver and will reflect in the Settings window. 



 
 

 

 



 
 

Step 7: Open Trimble Access application on the tab. 

 

 
Step 8: Main window will open up. Click on NW corner tab as shown in the following slide. 



 
 

Step 9: Click Instrument and GNSS functions. 

 

 
Step 10: Choose Bluetooth icon and clickOK tab as shown below. Bluetooth window will open up.  



 
 

Step 11: Select paired Trimble R8s Rover receiver, which is just paired, for first two drop down menus 

as shown below and click Accept tab. Press Esc tab to return to main menu. 

 

 
Now Getac tab and Rover receiver both have been paired, connected, configured and ready to use. 

Step 12: Click New tab to create a new project. New project window will open up. 



 
 

 

 
Step 13: Provide a Name and Description (optional) to the project. 



 
 

Step 14: Click Create tab at SE corner. New job window will open up. 

Step 15: Provide a job name and click on Coord. Sys. Select coordinate system window will open up. 

 

 
Step 16: Click radio button of Select from library as shown below and click Next tab. 



 
 

Step 17: Select System, Zone, Datum and fill the approx. height of the terrain and click store tab. 

 

 
Step 18: Click Enter tab at SE corner. 

Click on units and check the details as follows 

Click on Additional settings  and check the details as follows 



 
Click on accept 

 



 
 

 

 
 

Step 19: Click on the NW corner tab on the main screen to select Settings and then Survey Styles. 

Survey Styles window will open up. 

 



 
Step 20: Click New tab. Style details window will open up. 

 

 
 

Step 21: Provide the Style name and Survey type. Click Accept tab. New window will open up. 

 



 
Step 22: Click Edit tab for Rover options. Rover options window will open up. 

 
 

Step 23: Provide the information as shown in the slide below.  



 
 

Step 24: Provide Serial number of R8s receiver (Optional). 

 
 

Step 25: Elevation mask and PDOP mask default values can be altered if required. 

Step 26: GNSS Signal Tracking can be checked for desired constellations. Click Accept tab. Again, we 

will come back to new window.  

Step 27: Click Edit tab for Rover data link. Rover data link window will open up. 

BROADCAST FORMAT 

WILL BE RTCM3Net OR 

VRS (RTCM) FOR 

CORS 



 
 

Step 28: Select Type as Internet connection. Click on GNSS contact. A GNSS contact list will come up. 

 

 
 

Step 29: Select desired GNSS contact, edit existing or create a new GNSS contact. Accordingly, a new 

window will open up. 

 

 

Step 30: Here we will provide the IP address of Remote Server and IP Port of communicating Rover. 

IP Port will be unique for communicating Rover. There may be other Rovers communicating to the 

same server but IP Port will be different for different Rovers. 

Below a new GNSS contact SOI SERVER SGW has been created. Click the Store tab.  



 

NTRIP user name dgrb1 

      or 

   dgrb2 

      or 

   dgrb3 

 

 

NTRIP password dgrb1 

      or 

   dgrb2 

      or 

   dgrb3 

 

 

Ip Address 

103.205.244.106  

Port  2101 

 

 



 
Click accept and go to Topo point 

 
 

Step 31: Click Accept tab. We will return to main menu. 

 

 

Step 32: Click Measure, select your Survey style and select Measure points as shown below 



 
 

Step 33: Processing bar will appear for establishing connection to the Server. 

 



 
Step 34: A tick will be displayed after successful connection as shown below in circle. 

 

 
 

Step 35: click in option and select QC1&QC2 

 

Step 36: RTK solution will be Float or Fix as shown in the circle below. Point name, Code and 

Antenna height can be provided if accepted. To accept click on SE corner tab as shown below. More 

points can be measured if we continue to store points. 

To view all format “click ALL” 

Select the format to be used and click Accept 

For CORS the format are vrs,fkp and mac 

 



FIXED  

 

 

 

 
 

The Rover point collected will instantly give corrected coordinates with respect to Base. 

 

 

 

 

 

 

RTK:FIXED H:0.012m 

V:0.024m 

LATEN

CY 



SOP for Export RTK data file 
 

Click on Trimble Access in your FDC (Getac) 

 
 

Open your RTK project 

 

 
Open your RTK Job (eg. RTK DEMO) 



 
 

Now click on Export tab in your FDC 

 
Export page will open.  

Different File formats are given. Here select file format as “CSV WGS-84 lat longs” 

In “File name” select your desired path 

Select “Accept” 

Now file has been exported in Lat Long format as path given and file will be opened in MS excel. 

 

Again you will be back in your Job page 



 
Export page will display again 

 
 

Now we have to take coordinate in Easting & Northing format. So select “Comma delimited 

(*.CSV,*.TXT)” in File Format. 

 



 
 

In “File name” select your desired path  

Select “Accept” 

 
 

Select “All points” from options and click on Accept. 

Now file has been exported in Easting & Northing format as path given and file will be opened in MS 

excel. 

 



Annexure ‘B’ 

R8S INTERNAL STATIC 

For static observation we have to first create the job & survey style using Trimble access in your field 

controlling device. 

Open Trimble Access a default window will open 

 

 To create a new project, click on new. 

 

Give the name of your project, n click on create. 

A new job window will open. Give the job name  



 

Click here to set the coordinate system. 

 

Click the option –“Select from Library” 



 

Select the coordinate system, Zone, Datum& approximate project height, and click on store. 

You will be redirected to the job property page. Rest all the settings are by default. 

 

Now we will create a survey style for static observation. 

Click on the main menu icon o the left most corner of your field data controller. 

Go to –“Settings>Survey style” 



 

Click on new to create a new survey style 

 

Give the name of your” survey style, style type”  



 

Click on Accept. 

A new window will open. 

 

Select –“Rover options” 



 

Input your –survey style, antenna type, antenna height, logging device& logging interval.  

Use Antenna measurement method-“CENTER OF BUMPER” in case of tripod 

“Check in all the GNSS signal tracking” as shown below. 

 

Click on Accept 

Now you can start your static survey by centering & leveling your GNSS receiver in the ground. 

Switch on the power button of your GNSS R8s receiver. 

 



 

Now in your field data collector unit  

Open your job  

  

Click on measure it will ask you to select your survey style, select your survey style 



 

It will now establish Bluetooth connection of your FDC to R8s Antenna 

  

After establishing Bluetooth connection it will ask for the point name 



 

Enter the point name, choose the method fast static, and enter the instrument height. 

Click on the option to enter the time interval for your static observation, a new window will open up  

 

Click on auto store point, select the time interval for your static observation and click on enter. 

You will be redirected to the previous window. And at the bottom it will show you the time remaining 

to complete your observation. 



 

 

 

Static observation file is available in in the project file in the following path: 

C\Program Data\Trimble\Trimble Data\”User Account”\Project\*.t02. 

This data is then processed in TBC software to get the final coordinates. 
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 STEP -1 

CREATING A NEW PROJECT 

 
Open the “TRIMBLE BUSSINESS CENTRE” software. 

 

1. Start>program files>Trimble Office> Trimble Business Centre> Trimble Business Centre 

 

 
 

 

 

 

 

 

 

 

 

                                  

 

                          The following page will display. 

 



 
 
1. Click Start New Project 

The following page will display. 

 

 
 

           Click ok. 
 

 

The following page will display. 

 



 
 

         1.  Select the Following Command 

 

                Menu>File> Save Project 

 

 

 
 

 

 
 

  The following page will display. 

 



 
 

 

 

 
NOTE: It will save in default path: “C/Documents/Trimble Business Centre”.  

User can save it to any specified required path. 

 

THEN CLICK SAVE.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

     

 



STEP 2 

PROJECT SETTING 
1. Menu>Project > Project Setting 

 

 
 

                                               The following page will display. 

 

 
 

Click Change 

 



 
 

Click Next 

 
 

Click Next and select coordinates system as per requirement. 



 
Click Next 

 
 

Click Next and select Geoid model (the latest geoid model is EGM -2008) 

 



Click Finish. 

 

 
Click OK. 

 

 

 

STEP-3 

DATA IMPORT 
  

“TBC can import data in its raw ( *dat,*.T01,*.T02) as well as in RINEX format” 

1. Menu>File>Import 

 

 



 
The following page will display. 

 

 
 

Select Your Data and Then Click Import 

The following page will display. 

 
 

“Here we can edit the point id & instrument height if required and details regarding the field 

observation can be checked.” 

THEN CLICK OK. 

 



 
(After the raw data files are imported, the plan view shows all potential baselines (unprocessed base lines)  
in green color in the survey network. Because the data is raw static data, the baselines must still be 
processed.) 

 

 

STEP-4 

PROCESSING OF BASELINE 
 

1. Click Add co-ordinate button  

 

Note: “It can be done also by selecting the point and then “right click>Add-coordinate” 

command” 

 
Add the known coordinates 

 



Select Co-ordinate Type  Global  

 

Key in your “Latitude, Longitude & Height” and assign it as Control Quality. 

 

Click  Ok  

 

2. Menu>Survey>Processing Baselines 
 

 

The following page will display. 

 
 

 

Click Save. 

Go to next line  

 

 
 



 
 
If the solution is fixed and there is not any flag symbol on the baseline save the line , otherwise rectify it with 

 the help of elevation mask and session editor.  

NOTE: The blue potential vector showed that the unprocessed base line is processed now. 

 

To open session editor >select baseline>right click the selected baseline>click on session editor 

 

 
 

The following page will display. 

 
Here ,satellite for complete duration of observation  or part of it can be disabled  



 
 

To chose which satellite or part of it to be disabled> select baseline>right click the selected baseline> 

click on baseline processing report 

The following page will display. 

 
 



 
 

Here, the time for which residuals are not near the zero line has to be disabled in session editor. 

The baseline processing report can be opened in web view or tab view >Reports(in main menu)>Report options> 

Baseline processing report 

 
NOTE: The blue potential vector showed that the unprocessed base line is processed now. 

  

 *Select types of ephemeries through which you want to process ,e.g. broadcast and precise. 

 



  
 

 
 

Precise Ephemeris can be used here if available.  

 
 



 
 

 
 

Elevation mask can be changed here, if required. 

Loop Closure 
Now before going for the adjustment the loop closure must be checked. The Loop Closure Results report is a 

useful way to find large blunders in the data set, Such as errors with antenna heights, one point with different 

name or different point with same name.However,loop closure can only be checked in case of close figure 

For this select the command 

 

 Menu> Survey> GNSS loop closure  

 

 

 

 

 

 

 

 

 

 



 

 

The following page will display. 

 

 

 
 

 

 

 

 

 

 

 

 

 

 



                           STEP-5  

NETWORK ADJUSTMENT 

 
“Once all baselines in the control network have been processed and reviewed, you can adjust 

your survey network” 

 

SURVEY> ADJUST NETWORK 
 

 

Note:  

If the elevation (MSL height) of a station (Bench Mark) is available, then the adjusted 

vertical control can be obtained from the network up to sub metre level accuracy.  

 

Click Add co-ordinate button  

 

Note: “It can be done by selecting the point and then “right click>Add-coordinate” 

command” 

 

Select Co-ordinate Type  Gird  

 

Key in your “MSL Height” and assign it as Control Quality. 

 

Click  Ok  

   

Select the following command  

Menu>Survey>Adjust Network 

The following page will display. 

 
 

 

The following page will display. 

 



 

 
 

 

 

Check on   “2D & h” box if MSL Height to be fixed then check on “2D & e” box 

Click  Adjust 

 

NOW Click  Weighting This step is required if the value shown below the 

Postprocessed vector (1.87 in this case) is not coming near about 1 

  

 



 

                                                     

                                                 Make a click on * in Post processed vectors tab: 

Now again “Adjust” the data 

Note: For Adjustment Report  

 

 
 

 

Point to be checked in Network Adjustment Report 
 
         Network Reference Factor must be one or near to one 

            Chi Square Test  must be passed 

            Horizontal and vertical error must be in reasonable limit 

           All  vector must be in black colour under Adjusted GNSS Observations 

 

 

 

 



 
 

 

 

 
 

 



 
 

Disclaimer 
This SOP is made assuming that user has some previous knowledge of GPS data processing ,However for 

user with no previous knowledge of GPS data processing ,hands on training is recommended. 
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SOP for GNSS Observation in Order to Determine Latitude, Longitude & 

Ellipsoidal Height and subsequently use of Geoid Model for National 

Hydrology Project. 

The coordinates obtained from GPS/GNSS observations are burdened with many errors like Satellite 

Clock and orbit error, Ionospheric delay and Topospheric delay, Receiver Noise, Multipath and 

Receiver Clock error. Due the above errors the coordinates obtained are inaccurate and needs to be 

corrected before use.  

To minimize the effect of these errors the GPS/GNSS data of observation points needs to be processed 

with reference to some known reference stations whose coordinates are accurately known to us. 

The reference stations are of two types 

1. CORS Network established by SOI: Active Network of Reference Stations 

2. SOI GCPs: Passive Network of Reference Stations 

1. CORS Network established by SOI: Active Network of Reference 

Stations 

• Continuously Operating Reference Stations CORS are geodetic quality GNSS receivers and 

antennas that are permanently installed at a Reference Station (RS) having very accurately pre-

determined coordinates. 

• These Reference Stations collect GNSS data continuously, and transmit data via Internet to a 

central server (Control & Processing Centre).  

• The incoming data is processed at the server to generate corrections which are made 

available to users over the Internet in real-time in order to get the accurate coordinates. 

• To get accurate coordinates using the CORS network is known as Network Real Time 

Kinematic (NRTK) survey technique. 

• To avail the facility of NRTK survey users needs to have a RTK enabled GNSS receiver 

with internet connectivity.  

• Different brand receivers are available in the market. The Standard Operating Procedure (SOP) 

to carry out NRTK survey is different for different brand receivers. 

• At present SOI is using Trimble R8s GNSS receiver for NRTK survey. The SOP to carry out 

NRTK survey using Trimble R8s GNSS receiver given in Annexure ‘A’. 
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2. SOI GCPs: Passive Network of Reference Stations 

• The states where CORS network is not available, the SOI GCPs can be used as reference stations 

to get the accurate latitude longitude and ellipsoidal height of the survey points.  

• The SOI has established Ground Control Point (GCP) Library of about 2500 Ground Control Points 

in the entire country and derived their coordinates (Latitude, Longitude and Ellipsoidal Height) with 

high accuracy. These GCPs define the Horizontal datum of the country and can be used for various 

surveying, mapping and developmental activities. These GCPs has cement concrete 

structure/Monumentation and can be located on the ground by their description which is available 

with SOI. These GCPs are passive reference stations. 

• To get the accurate coordinates of survey points for any surveying and mapping activity the 

GPS/GNSS observation of survey points needs to be carried out for 1 to 2 hours with reference to 

SOI GCPs in static and relative/differential mode. The GPS/GNSS data thus collected needs to be 

processed with reference to SOI GCPs in order to derive the accurate coordinates (Latitude, 

Longitude and Ellipsoidal Height) of new survey points. 

• The coordinates of reference GCPs which is required during the post processing can be obtained 

from SOI as per departmental policy. 

• In this process at least two Observers with two GNSS receivers needs to occupy the Reference 

GCPs falling in the area of work and one or more observers needs to occupy the new survey points 

with 1 to 2 hours common observation duration.  

 

• This technique is known as static survey technique and require the at least three GNSS 

receivers. More receivers will increase the progress of the work. 
• The static survey requires: 

o 1 to 2 hours GNSS Data collection using GNSS receiver 
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o GNSS data downloading from the receiver to a computer having GNSS data 

processing software and finally 
o GNSS data Processing using software 

• The SOP for GNSS data collection in static mode using a Trimble R8s GNSS 

receiver and downloading to a computer is given in Annexure ‘B’. 

• The SOP for GNSS data processing using Trimble Business Center (TBC) 

software is given in Annexure ‘C’. 

• The output of NRTK as well as static survey is accurate Latitude, Longitude and 

ellipsoidal heights. 

• In order to get Orthometric Height of survey points, the Latitude, 

Longitude and Ellipsoidal heights of survey points can be supplied to SOI. 

The SOI use the Geoid model and convert the ellipsoidal heights into 

Orthometric Heights. 

• The SOPs as mentioned above are given in Annexure ‘A’, ‘B’ and ‘C’. 

  

 

 


	R8s_NRTK_Annexure A
	R8s_STATIC_Annexure B
	SOP TBC_Annexure C

